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Part 3
An introductory guide to the M7CL group of consoles including features 
included in Version 3 Firmware and the M7CL-48ES hardware.

Quick Start Guide
A guide for people using M7CL Version 3 in the real world.

These guides are for people about to use the 
M7CL for the fi rst time, or for experienced 
users requiring some tips and tricks for better 
understanding of M7CL and its PC based 
software partner the M7CL editor.
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M7CL Quick Start Guides.

The M7CL Quick Start Guide is in multiple parts.  It is available as a download from www.yamahaproaudio.com in 
the “Self Training” area.  Also available is the revised M7CL Short-cuts and Tips List.

Part 1 is an introduction to the M7CL and its variations and goes on to describe the basic operations of the con-
sole to the level of a similar featured analogue console.

Part 2  introduces the extra features provided only by digital consoles; the internal effects rack package and the 
basic use of scenes to store and recall parameters. 

Part 3 looks at scene memory use in more detail and the PC/Mac based software for remote control and setup; 
Studio Manager and M7CL Editor.

M7CL-48ES users may also wish to look at Yamaha’s EtherSound Setup Guide.  This explains the basic principals of 
designing an EtherSound network.  
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M7CL can store 300 scene memories or snapshots.  In addition to the 300 numbered memories there is the default 
read only Scene 000 and also the ‘current console settings’ which are either the same as a scene or an edited 
version of a scene.  These are in a special memory buffer which is also retained in case of power failure.  

Scene 000 is “R” read only.  
When it is edited the yellow         
     appears. You cannot save 
to scene 000.

When the console parameters are edited to a position you want to keep, press the SCENE MEMORY up/down key to 
choose a numbered location for the new scene.  The chosen number will fl ash.  It is not necessary to be displaying 
the scene list, you can do this at any time.

Scene Management and other memorised features.
M7CL can memorise all of its mixing parameters such as EQ, dynamics and fader levels.  These memories are 
stored into a “snapshot” or “scene”.  The analogue equivalent is “marking up” the desk on the familiar printed 
sheets of circles. This “scene” represents the best positions for all the parameters at that particular point in 
time.  If soundcheck and rehearsal time allow, it is possible to create a scene snapshot for each song or act of the 
performance, including the preshow walk-in music and end show exit music and scenes for each support act too. 

However never forget that live show mixing is a dynamic activity and that a series of scene recalls cannot always 
cope with the unexpected performance change or react to the change in room acoustics due to the audience. This 
guide explains how to take advantage of the scene snapshot system, whilst using the Recall Safe and Recall Focus 
functions to maintain fl exibility and keep dynamically mixing your show.

In addition to scene information M7CL also remembers handy libraries of parameter information like the EQ, 
GEQ and dynamics libraries and set up features like patch information, User Defi ned Key and other preferences. 
Together all these memories add up to be a “session” or “console” fi le and these fi les can easily be copied to 
another console using a USB storage device or Yamaha Studio Manager. M7CL can only contain a single “console” or 
“session” fi le, but by connecting a PC running Studio Manager and M7CL Editor software, scenes can be extracted 
from one session and merged into another.

The SCENE LIST pop-up.

To see the SCENE LIST pop-up 
press the scene fi eld area of 
the screen.

How to store a scene.
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To recall a scene use the up/down keys to fi nd its 
number and then press RECALL.  The desk will reset 
itself to the chosen scene.  You cannot recall “empty 
scenes” with no data stored in them.  If you want to 
start from a fresh clean desk choose Scene 000.

Press STORE (on screen or on desk), then OK on the 
confi rmation box and the scene is stored.  The scene 
number shows in the function access panel and the       
goes out until another desk change is made.
For really fast scene storing you can disable the con-
fi rmation in SETUP Preferences.  Now a simple double 
press on the STORE key will store using the current 
scene name.  You can update the scene names later.

Clear the existing name (Initial Data) with the CLEAR key. Enter a scene name and a comment if wanted.    The 
scene is always given an automatic time stamp when it is created and this appears in the SCENE LIST.

How to recall a scene.

Undo Options.
If after storing or recalling a scene you realise that you 
have made a mistake; perhaps you recall a scene with 
all channels muted, or over-write an important scene, 
there is one step of “undo”.  You can access this from 
the SCENE LIST pop-up. The “Undo” remains until you 
next store or recall.
User defi ned keys can be programmed to do “Undo 
store” or “Undo recall” functions directly.

Next press STORE and the SCENE STORE keyboard pop-up will appear.  This lets you name the scene and provides 
extra space for a comment or longer scene name.  If you store to a location containing a previously stored scene, 
this scene will be lost. (But see “Undo Options” section.) Scenes can be locked against this but generally be careful 
to choose a vacant scene location to avoid over-writing a valuable scene.
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Managing the scene list.
Scenes appear in the list next to a position number.    
Above the list are Cut, Copy, Paste, and Insert option 
buttons so that you can re-order the scene list.  This 
also lets you clear un-used scenes.  It is important to 
realise that the scene number that you stored the scene 
into, is only a location and not part of the scene name.  
If you cut and paste scenes they will change number.  

There is an “Undo” button for the scene management 
options, but this is only for one action back.

Editing single scenes.
Scene information can be edited by recalling the scene, making the required changes 
and then restoring to the same location.  Alternatively the session or scene can be 
opened in Studio Manager M7CL Editor and changes made on an offl ine PC.   Scenes 
can be locked from being over-written by pressing the grey square in the padlock icon 
column.  Scene 000 is read only and cannot be over-written.

Editing multiple scenes; Global Paste.
When you have multiple scenes that all require the same edit it is convenient to use Global Paste.  A typical 
example would be when a musician gets a replacement instrument, like a new bass guitar, the engineer needs to 
change the EQ setting in every scene where that new bass is played.
Access the Global Paste popup from the tab on the SCENE LIST Screen.

Tip;Tip; If you use the Up/Down keys to move to new 
scene number, but change your mind and don’t recall 
a scene, press Up/Down together to return to the cur-
rent scene number.
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Limiting the effects of scene recall.
Scene recall is an extremely powerful function to help the sound engineer make many rapid changes to the console 
between songs or scenes.  However, there are many circumstances when the engineer needs some changes but does 
not want to implement other changes.  M7CL has two different solutions to this limiting of scene recall; Recall Safe 
and Focus.

Recall Safe and Focus.
When a scene is stored, all the parameters of all the channels are memorised, regardless of any safe settings, 
but when a scene is recalled with Recall Safe or Focus settings applied, the specifi c parameters of channels to be 
recalled are limited by those settings, and the parameters remain unchanged by the recall.  Recall Safe can be 
applied to a whole channel or as Partial Recall Safe be applied to individual parameters.
Recall Safe affects the parameter in all scenes but Focus affects the parameter only when that specifi c scene is 
recalled. For a more in-depth understanding of Recall Safe consult the “M7CLV3 Recall Safe Guide” available from 
the Self Training pages of www.yamahapraudio.com

Recall Safe; typical use examples.
1. If a special channel is added to an existing show made up of many scenes.  This might be a presenters mic 
or safety announcement mic.  Each time a scene is recalled this mic channel will “disappear” because it is not 
part of the newly recalled scene.  By placing the mic channel in “Recall Safe” the scene recall does not affect that 
channel and the mic will stay as before the scene recall.
2. Another common example is when using a scene for every song in a bands set.  During the fi rst song the 
engineer improves the sound of the bass drum by altering the EQ.  When the second song starts the bass drum 
EQ is recalled with the original EQ and the engineer must repeat their alterations.  This workload accumulates 
throughout the set as more channels are altered.  By using “partial recall safe” just the EQ of those channels can 
be removed from scene recall so that it remains unchanged even when the fader level, sends, on/off etc is being 
changed.
3. GEQ and rack settings can be recall safed.  This is quite desirable so that any system or monitor GEQ 
applied in song one, is not undone when song two starts.

The Global Paste popup is a powerful and complex 
screen; it has three main areas to consider;
1. Choose the kind of parameters you want to edit 
from the tabs at the bottom.  In, Out, Rack or Patch.
2. Choose the parameters and the channels you 
want to edit. (In our example this could be restricted to 
just the EQ for the bass guitar).
3. Select a range of scenes to edit; starting from 
and ending at.  

11

3322

This Global Paste screen shows the settings to edit the 
EQ of channel 9 (Bass) in all scenes from 2 to 8.

PASTE; when the [PASTE] button is pressed all the 
selected parameters of the selected channels will be 
changed to the position of the current scene on the 
surface.
All selected scenes will have a new Bass EQ.

11

22
33

Tip;Tip; If there is a scene within a list that does not need 
editing (for example the old bass is still used) then 
that scene should be locked against editing with the 
padlock symbol.
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To apply Recall Safes;
The Recall Safe pop-up is in the Channel Job area.  Press the CH JOB area on the screen and then select RECALL 
SAFE, the pop-up will appear.

Recall Safes can be applied from this screen and the 
Safe Parameters can be selected.  
To apply a Safe, select the channel to display its setting 
in the lower part of the pop-up. Select the parameters 
to be safed (eg ALL or HA and EQ).  Turn on the Safe 
with the SAFE button.  This setting can be applied to 
many channels quickly by using the SET BY SEL function 
in the box above.

Channels with all parameters safed are shown green.  
Channels with partial safes are shown blue.  There are 
many possible partial safe combinations but all are 
shown in blue.

Turning safes on and off.
Safes can be turned on and off from the Selected 
Channel View and there is also a short-cut to the RECALL 
SAFE MODE pop-up.  If the safe is set to a partial setting 
this will be indicated here and the partial setting 
remains even when switched off.

It is easy to create mute scenes by selecting all the buttons other than CH ON from the SAFE PARAMETER SELECT 
part of the RECALL SAFE MODE pop-up, and applying this to all channels.  In this case each scene will only operate 
the channel ON/OFF parameter.  Check to Safe all the RACK, NAME and PATCH boxes too.

Note;Note; There is a difference between [ALL] and all the parameters buttons together.  Be aware of the exception 
that channel link, MIX/MATRIX bus setup, TO STEREO/MONO, PAN/BAL, LCR, and MUTE/DCA Assign are also 
recalled with ON/OFF keys, because these parameters are not subject to recall safe (always recalled) or can be 
safed only with ALL.  For a more in-depth understanding of Recall Safe consult the “M7CLV3 Recall Safe Guide” 
available from the Self Training pages of www.yamahapraudio.com
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The focus screen can be accessed from the SCENE LIST pop-up by pressing the [FOCUS] tab below the scene list.    
It is important to understand that Focus differs from Recall Safe; Recall Safe is global to all scenes and Focus is 
specifi c to a particular scene.  Also the selectable parameters are different.

Focus (or Recall Focus); Typical use examples;
Focus is another way of limiting the amount of information that is recalled when the chosen scene is recalled.

1. Multiband shows.  In a multiband line up show each engineer wants his own GEQ setting, but also they 
want changes to be possible without scene recall “undoing” them.  Because Focus is available on a scene by scene 
basis this is possible.  Use Focus to remove the RACK from recall in all scenes except the fi rst scene of each band’s 
set.  Now the GEQ settings will change only when a new band starts.
2. Patch Changes.  In a live recording set up it is required to have the mics connected to the channels of 
the scenes for recording, but for playback use the same scenes and have the recorder connected.  By recalling 
a “record set up” scene the mics can be patched to the channels or by recalling a “playback set up” scene the 
recorder can be patched to the channels.  Use Focus to remove the INPUT PATCH from scene recall for the actual 
scenes, but keep the INPUT PATCH within Focus for the two special “set up “ scenes.

How scene recall can be limited; a summary.
By Focus.
Set and stored for each scene in the SCENE 
LIST pop-up.

Rack
Effect preset and parameters, but not patching.
HA
Head Amp, Level, +48V, Ø
Input patch
Input patching, Insert patching, Direct Output patch-
ing, but not on/off
Output patch
Output patching, cascade patching.
IN 
Input channel parameters; Name/Icon, EQ+ATT, dy-
namics, mute and DCA group settings, on/off, pan/bal-
ance, fader.  Insert and direct on/off. 
OUT 
Output channel parameters; EQ, dynamics, on/off, 
fader and the With send settings if pressed.
(With send)
ON/OFF and send level settings for mix and matrix 
sends.

By Recall Safe.
Set for all scenes in the RECALL SAFE MODE 
pop-up.

Global recall safe
Input patch, Input name.
Output patch, Output name.
Individual rack units 1 to 8.

Input Channel
All parameters or partial safe menu of;
HA, EQ+ATT, Dyn 1, dyn 2, Mix on, Mix send, Matrix on, 
Matrix send, Fader, on/off.
Stereo/Mono master Output Channel
All parameters or partial safe menu of;
EQ, Dyna, Matrix on, matrix send, fader, on/off.
Mix master Output Channel
All parameters or partial safe menu of;
EQ, Dyna, Matrix on, matrix send, fader, on/off. With 
Mix Send.
Matrix master Output Channel
All parameters or partial safe menu of;
EQ, Dyna, fader, on/off. With Matrix send.
DCA groups
All parameters or partial safe menu of;
Level/on



9

                 M7CL Quick Start Guide Part 3

Saving and Loading data.
Storing and recalling operations relate to scenes within a console fi le.  Saving and Loading relate to adding or 
copying fi les from the console.  The console fi le is made up of various libraries but these are all linked together so 
that they can all be saved or loaded together in one easy fi le.  These fi les are common to both the M7CL 32/48 and 
M7CL-48ES, but no other console.
In addition to the scene memory (including the patch scenes) the console also remembers the various console 
settings and preferences not included in the scenes.
All this information can be backed up to a simple USB storage device.

What is in a scene?
When a scene is stored it is useful to know what is included in the scene and can be changed by scene recall 
and what is not.  However just because things are not remembered by scene recall doesn’t mean they are not 
remembered at power down or are not included in the whole console fi le.  
These text boxes should make it clear what is stored in scene memory and what is not.

Included in Scene Recall.
Head Amp (Level, +48V, Ø )
Ext Head Amp (Port, Level, +48V,)
Scene Comment, Time Stamp
Name/Icon
Patch/Routing (Input, Output, Insert, Direct, Monitor, 
Cascade, Rack)
Insert (on/off, position)
Direct Out (on/off, position, level)
EQ (All parameters inc HPF)
ATT (digital attenuator)
Dynamics 1 (All parameters)
Dynamics 2 (All parameters)
Matrix levels, on/off.
Matrix sends (Bus setup, on/off, level, pre/post, pan)
Mix sends (Bus setup, on/off, level, pre/post, pan)
Pan/balance (Position Stereo/ Mono/LCR)
DCA (assignment, level, mute)
Mute group (assignment, on/off)
Faders and on/off
Rack (all parameters)
Rear panel input to talkback routing (and levels in 
MONITOR Screen)
Focus 
Cross fade (On, time)
Channel link settings
To Stereo/Mono (On, pre/post)
Cascade patching

Not included in Scene recall.
but still remembered for all scenes.

User defi ned keys
Preferences
Brightness controls
OUTPORT delay and level settings
MIDI setup 
Wordclock
Master +48V
CUE Pop-up;  PFL trim inputs,  DCA trim,  PFL trim 
Outputs   
Monitor Pop-up; (levels, source on/off, mono, link)
Oscillator (all parameters)
Safe assignments (mute, recall)
Passwords/Admin/guest settings
Screen page or pop-up
Sends on fader selected
Metering point selection
External HA to Slot assignment and HPF.
User Access Level
Network settings
Clock!!
Slots and MY Card settings
User Libraries
 EQ/HPF,  (User and ROM)
 Dynamics (not key-in), (User and ROM)
 GEQ,  (User only)
 Effects (User and ROM)

Yamaha does not make and sell the USB storage 
devices, but these are widely available from 
computer and electronics stores and from many 
manufacturers.  When choosing a storage device 
remember that; M7CL is USB1.1 compliant, so 
both USB1.1 and USB2.0 will work.  Storage 
capacity must not exceed 16Gig.  The drive 
can be formatted to FAT12 FAT16 or FAT32 but 
must not be partitioned.  You can format a new 
drive in M7CL, but remember formatting an 
old drive erases all its memories.  Most  USB 
memory devices work, but Yamaha have a list 
of tested ones on www.yamahapropaudio.
com (Downloads>Technical Documents & Data> 
Utilities and Data> Mixers)
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Saved on USB storage device as 
ALL DATA fi le.
All the scene data from the above list for all the 
scenes.
The current scene (the scene in use at the time of 
SAVE).
External HA to slot assignment
Safe assignments
Work Clock settings
CUE Pop-up settings;  PFL trim inputs,  DCA trim,  PFL 
trim Outputs   
Monitor Pop-up settings; (levels, source on/off, mono, 
link)
Metering point selection
MIDI settings
Outport settings (delay and level)
User Libraries
 EQ/HPF,  (User and ROM)
 Dynamics (not key-in), (User and ROM)
 GEQ,  (User only)
 Effects (User and ROM)
User Access Level
Preferences
User Defi ned Keys

Saving data to a USB storage device.
The scenes and set up of an M7CL console can be stored to an external USB storage device.  This serves to back up 
the console’s internal memory and allow transfer of the data to another console in another territory.  Files made on 
either M7CL32/48 or M7CL-48ES channel version will open in the other version.
In the unusual case that fi les were created in an M7CL32/48 loaded with MY16-ES64 EtherSound cards and using 
SB168-ES external stageboxes, fi les must be “converted” to work with consoles not using the MY16-ES64 cards; 
even if it is M7CL-48ES.  The reverse operation also needs “conversion”.  Just press [STAGE BOX DATA CONVERSION] 
button and follow the on screen instructions.  The conversion process does not alter the data on the USB device.
Simply inserting a USB storage device will open the SAVE /LOAD pop-up screen.
If your stick is already connected then you can access the SAVE /LOAD pop-up from SETUP in the function access 
panel and then press SAVE/LOAD.

Pressing the SAVE button will result in an ALL DATA save.  
The text box explains what is included in that data fi le.

Stored on User Authentication Key.
User Access Level
Preferences
User Defi ned Keys

You can also access the CREATE USER KEY pop-up from 
this page.  In addition to Administrator-set user access 
privileges the key stores your preferences and User De-
fi ned Key settings.  So it’s a useful way to transfer User 
Defi ned Keys and preferences to another console when 
you are starting a new project.

Loading data to the console from a USB storage device.
When an ALL DATA fi le is loaded into a M7CL all the data in the console is over-written. (Except the few items like 
Passwords in the text box below).  Similarly if a LIB scenes-only fi le is loaded all existing scenes are over-written 
but setup data like User Defi ned Keys are retained.  LIB fi les are discussed later.
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Memorised at power down on 
the console but not in ALL DATA 
fi le.
Passwords 
Screen page
Brightness controls
Network settings
Clock (time/date etc)

Not stored anywhere!
Screen page pop-up. (but can be bookmarked) 
Talkback on, 
Cue on  (always off at power up)
Osc on (always off at power up)
Monitor dimmer on  (always off at power up)
Console Lock  (always off at power up)
Monitor, Talkback and Headphone pots (but shouldn’t 
move in transit!)

Other memorised data.
Some things are memorised by the console but not included in the ALL DATA fi le.  And somethings are not 
memorised by the console at all.

Management of M7CL console fi les.
In the SAVE/LOAD screen you can COPY, PASTE and DELETE items on your USB storage device, regardless of what 
kind of fi le they are.
However only certain kinds of fi le can be loaded into M7CL.  Only ALL DATA and USER KEY fi les can be created on 
M7CL but Studio Manager M7CL Editor can save Scene Only data. There are also fi rmware fi les and Help Menu fi les to 
recognise.  See the guide below.

M7CL fi les. 
All.M7C  This is an ALL DATA console set-up fi le that in-
cludes all the information listed in the text box on page 
8. All.M7C fi les can be created on either the console or 
the M7CL Editor and these fi les can be used for transfer-
ring data between consoles and editors.

User Key.M7U  This is the User Authentication key that 
carries the user preference and access information 
listed on page 8. The user access privileges may be cre-
ated, viewed and edited on the Console or the editor, 
but only the console can view and edit the preferences 
and User defi ned keys.

LIB.M7C This is a fi le of “scene-only” data created 
within the Studio Manager.  It does not include other 
non-scene recallable data like User defi ned keys or EQ 
etc libraries.

Firmware.PGM fi les. There are four different  .PGM fi les 
that make up the console fi rmware (actually two for 
M7CL32/48 and two for M7CL-48ES but they always get 
downloaded together and the consoles only load what 
they need) and these will self load at power up.  (With 
a confi rm dialogue pop-up) They cannot be loaded from 
the SAVE/LOAD screen.

M7CL_EN.XML  There are several different language 
[Help] fi les available and these must be loaded from the 
save/load screen. 

name.YSE  This is a session fi le created and stored in 
the Yamaha Studio Editor format and it will not open in 
the console, only the editor.

New.M7C  Sessions saved on newer versions of Studio 
Manager appear as “New” on old console fi rmware.  Up-
date your fi rmware to access them.

NOTE;NOTE; there are two types of .M7C fi les; ALL and LIB.
 

How fi les appear in MS Windows.

How fi les appear in M7CL.
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STUDIO MANAGER and the M7CLV3 EDITOR.

Background and introduction to Studio Manager.

M7CL is not aimed at any kind of studio activity; it is primarily a live concert mixer so many people are confused by 
the Studio Manager title of its remote control and editing software.  In fact the Studio Manager and M7CLV3 editor 
are very well adapted to the needs of the live sound engineer; M7CL fi les can be opened on a PC, away from the 
console, and edited, saved and copied.  The fi les are small and can be easily emailed and scenes from different 
shows can be brought together to create a new fi le allowing seamless changes from any one scene to another.

The Studio Manager title comes from the software’s much broader capability to integrate with many other digital 
audio products found in studio environments.  Far from being limited to the remote control of a M7CL, Studio 
Manager can remote control several M7CLs, other Yamaha digital mixers, SPX2000s and Motif Keyboards.  In turn 
Studio Manager can be part of a Steinberg Cubase DAW setup and all the settings of these products can be saved in 
a single fi le launched from the DAW.

Of course this broader functionality is not relevant for the simple remote control and editing of M7CL, but it is 
useful to learn a little background now in order to understand later how you can save fi les that are from setups of 
multiple consoles used in a master and sub mix or cascade confi gurations later if ever needed.

Studio Manager

SPX2000

DM2000

MOTIF ES6/7/8

MOTIF ES6/7/8 Multi Part Editor

DM2000 Editor

Synchro-
nize

Synchro-
nize

Synchro-
nize

SPX2000 Editor

Hardware products

Open from a 
compatible DAW 
application

Start up Studio 
Manager in 
stand-alone form

Open an editor from 
Studio Manager
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What is Studio Manager and M7CLV3 Editor for?
The combination of Studio Manager and M7CLV3 Editor gives you the software to create and edit .M7 fi les on your 
personal computer (PC or Mac). These fi les hold all the parameter data for all the scenes in a setup and can be 
transferred to a console using a USB key.  Alternatively, by using the DME-N Network driver(PC) or Network MIDI 
driver(Mac) and a Cat5 crossover cable connection, the Studio Manager and M7CL Editor can be used "online" for 
remote control and monitoring of a M7CL console or direct exchange of data between the computer and console 
memory.

It is not required to ever use Studio Manager with a M7CL; the console offers all its features without any external 
computer devices, but Studio Manager adds very useful extra access.  The preparation chores like naming channels, 
patching I/O, setting effects units and parameters can all be done on your Personal Computer without the need 
to access the console; while you are at home, on the bus, or even on a plane.  Secondly Studio Manager offers an 
alternative interface when connected to a M7CL, this gives a different view, an extra control interface for dual 
operators and the possibility of remote or even wireless control using tablet type PCs.

Where can I get Studio Manager?
Studio Manager and the various editor programmes are available as free download from;

 www.yamahaproaudio.com 

From the DOWNLOADS page look for FIRMWARE AND SOFTWARE.

There are three things you should download for M7CL; 
1. The Studio Manager V2 Host (PC or Mac)
2. The M7CLV3 Editor (PC or Mac)
3. The DME-N Network driver(PC) or Network MIDI driver(Mac).   

Downloads from www.yamahaproaudio.com will always be the latest versions and compatible with each other 
and the latest console fi rmware.  Older versions of Studio Manager may not communicate with the latest console 
versions and so it is best to rely on downloads rather than a CD that may have come with the console or been 
loaned to you.  Any extra limitations caused by the ongoing development of the software will be explained on the 
website.

The Studio Manager software can currently be downloaded free of charge, but remember there is a "Licence 
Agreement" to check and you should only use the software as permitted by the terms and conditions of that 
agreement.

Note;Note; M7CLV3 Editor works in Studio Manager V2 Host.
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What kind of computer do I need?

For Windows 7
CPU: 1.4GHz or higher Intel Core/Pentium/Celeron family processor 
OS: Windows 7(32-bit, 64-bit; Ultimate / Professional / Home Premium) 
Hard Disk: 100 MB or more 
Memory: 1GB or more (64bit 2GB or more)
Display: 1,024 x 768 pixels or higher; High Color 16-bit or higher 

For Windows Vista
CPU: 1.4GHz or higher Intel Core/Pentium/Celeron family processor 
OS: Windows Vista(32-bit; Ultimate/Enterprise/Business/Home Premium/Home 
Basic) 
Hard Disk: 100 MB or more 
Memory: 1GB or more 
Display: 1,024 x 768 pixels or higher; High Color 16-bit or higher 

For Windows XP 
CPU: 1 GHz or higher Intel Core/Pentium/Celeron family processor 
OS: Windows XP Professional / XP Home Edition / XP Tablet PC Edition 2005 
Hard Disk: 100 MB or more
Memory: 256 MB or more 
Display: 1,024 x 768 pixels or higher; High Color 16-bit or higher 

For Mac OSX
CPU: Intel Core family processor
OS; Mac OS 10.5.8/10.6.x
Hard Disc; 100MB or more
Memory; 1GB or more
Display: 1,024 x 768 pixels or higher; High Color 16-bit or higher

Which Version of Firmware and Software should I use?

Yamaha constantly develops the M7CL mixing system, 
sometimes new versions are released that include new 
features and sometimes versions simply tweak the 
existing system to improve performance and “bug fi x”.  
When new console versions are released, new Studio 
Manager and Editor versions are often required to keep 
compatibility.   

All fi les saved in mixers are .M7C type fi les and these 
will open in all future mixer versions, however it is not 
possible to guarantee future fi les will still be compatible 
with older mixers.   For this reason Yamaha strongly rec-
ommends the use of current mixer fi rmware in all con-
soles. If you own the mixer, keep it up to date or visiting 
engineers may not be able to open their fi les.  If you are 
a touring freelance engineer carry latest fi rmware and 
USB key for upgrading.  Console fi rmware is provided 
free of charge on www.yamahaproaudio.com.

Yamaha always recommends the latest version of console fi rmware and the latest version of Studio Manager and 
M7CLV3 Editor.  This combination is compatible for on-line connection and synchronization, will have the latest 
features and least known bug problems.  However, we understand that in the real world there are older versions of 
consoles in circulation and that some engineers may have saved data in older versions of the SM and Editor.   

How can I deal with older versions?

The system requirements are subject to change with future updates and current information is given on the 
download pages of the website, but in Autumn 2010 all network equipped devices with;

This table is an example from October 2010; 
get the latest from www.yamahaproaudio.com
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Files saved in Studio Manager can have other formats (see page 11 of this guide).  If a fi le was saved as a .YSM or 
.YSE fi le in V1 of Studio Manager it will not open in V2 or V3.  To ensure that no fi les become unusable there are 
three versions of M7CL Editor available from the www.yamahaproaudio.com download pages.  These relate to the 
last V1,V2 and the latest V3 of the M7CL mixer fi rmware.   If you have existing V1 Editor fi les saved as .YSM or .YSE 
type fi les you need to use the V1 versions.  You can then re-save these as .M7C fi les that will load into any version.  
If the console is V3 then the newly saved fi le will be upgraded to V3 and you can move on to using V3 Studio Man-
ager and Editor.

Installing the software.
Full instructions for installing the software are available from the download pages.  The wizards will guide you 
through the installation.  Use the default settings unless you have particular requirements on where to install 
things.

If I don’t have access to a M7CL can I still get started and use the 
software?
Yes.  Once the software is installed correctly you can open the Studio Manager without a console.  However you 
should understand that the M7CLV3 Editor graphics are not the same as those in the console and that studying 
M7CLV3 Editor is not an effi cient way to learn how the actual console appears and works. 
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Windows can be sized but the contents do not scale.  
You must use scroll bars if your screen is not big enough.

When the Editor opens it shows the window INPUT 
CH 1-16.  

Using Editor Windows

M7CLV3

When the program opens, select the Setup parameter 
from the File menu.  Highlight the M7CLV3 Editor and 
click [Add->] to move it to the workspace.  Repeat this 
for the other editors if you need them for opening older 
Studio Manager fi les.
When the editors are in the workspace you should check 
the [Set Default] box so that you don’t have to do this 
next time you open Studio Manager.

Click the [OK] button and the Studio Manager Window 
will show the Chosen Editors.  

Double click on the Editor Icon to open the Editor.

(If you have a more complicated set up with multiple 
consoles you can choose to name each one by double 
left clicking on the name below the icon)

Opening Studio Manager and the Editor for the fi rst time.
The fi rst time you open Studio manager there are some setup chores to be done.

Open Studio Manager like any other programme;                               
 click “Start”..............

Tip;Tip; For Windows like INPUT CH 1-16 the View tab can 
be useful.  You can remove unused parts of the window 
from display, for example if you don’t need to see all 
the Mix sends you can hide them and have a smaller 
window.  This means you may not have to scroll to see 
the whole window and there is space to open other 
windows at the same time.
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Changing parameters
Use your computer mouse to set the controls shown in 
the Editor Window.  
For example;
Click and drag a fader up or down.  
Click a button on or off.  
Click and drag a rotary knob either clockwise or anti-
clockwise.
Double click on dB numerical values and type in a value.
Double click on the name (eg Ch14) and rename the 
channel. 

Enter SENDS ON FADER mode and drag mix send values 
up and down for setting monitor mix levels. Select your 
mixes from the Sends on Fader Window.

Use the Window tab to open other windows as required.  The better resolution your screen has the more windows 
you can layout.

Tip;Tip; In Sends on Fader mode the fader caps colour 
helps to show the chosen mix.  Grey faders are turned 
off channels.  (The ON button in this view is the Mix 
On not the channels On.)
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The SEL channel windows;
Main and Additional

In the M7CLV3 Editor there are two SEL channel windows;  Main View and Additional View.  Both views can appear 
the same,  they differ in how their displayed channel is selected.
Note also the  main view can access the libraries from buttons within the window, but these are greyed out in the 
additional view.

The selection of the Main View is by the [SEL] buttons, but the Additional View selection is  either by using the ar-
rows to increment and decrement the channel or by clicking on the [Select] bar to produce  a drop down box of all 
the channels to choose from.

For now it doesn’t matter which SEL channel you use, the Main View is probably a little easier, and it has the library 
short-cuts, but later when connected on-line to the console you may want to decide if you need the Studio Manager 
to show the same SEL channel as the console or a different SEL channel.  The real purpose of the Additional view is 
to provide a second independent control of the mixer when on-line.

Dragging a rotary knob.
To set the value of a rotary knob click on the knob and 
drag it round. The knob will reach an end-stop just like 
an analogue knob.  

Drag out, 
then turn

Tip; Tip; For greater accuracy you can click on the knob, 
drag the pointer out along the radius of a circle and 
then turn the knob as if it was a giant knob with this 
radius. This can be especially useful when using tablet 
control.   Alternatively, type a value into the text box 
above the knob.  
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Scene management using Studio Manager and M7CLV3 Editor.

Editing console fi les on the M7CL Editor.
Console fi les, stored to a USB storage device can be opened using M7CL editor.  Open a stored session with 
“File>Open” and browse for the USB storage device in “My Computer”.  Only .YSE fi les are displayed until you 
select Console fi les in the “Files of type;” box below the fi le name box.
The Editor can be used to change most of the scene parameter data.  Notably the Editor cannot be used for the 
items in the following text boxes.

Online with M7CL Editor.
When connected via the Ethernet port and “online” the editor can control the M7CL console.  Dragging the controls 
with the mouse will cause the mixer parameters, the screen images and faders to change and move.  Please note 
that until the “RE SYNC” operation is completed the Editor and M7CL may not show the same settings.  When “RE 
SYNC” is performed each parameter will be copied to the other device and it is important to make the correct 
decision when faced with the Re-Synchronize dialogue box;
Console->PC or PC->Console.

Managing scenes with the Editor.
The Editor session is just like the console session in that it contains 300 scenes.  Scenes can be stored and recalled 
from the MASTER window, and scenes can be viewed in the SCENE window just like the console.

Cannot be set by M7CL Editor.
(but still saved in .M7C .YSM or .YSE fi les)

Preferences
OUTPORT delay and level settings
MIDI setup 
Wordclock
Master +48V
CUE Pop-up;  PFL trim inputs,  DCA trim,  PFL trim 
Outputs   
Monitor Pop-up; (levels, source on/off, mono, link)
Oscillator (all parameters)
User Access Level

The Scene window.

File column on the left
Internal data column on the right

Cannot be set by M7CL Editor.
(and not stored in .M7C .YSM or .YSE fi les)

Network settings
Clock (day/date etc)
Passwords
Brightness controls
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Using the Scene Window.
The Scene window shows two columns.  
The right side column is headed “INTERNAL DATA” and the scenes listed in this column form part of an ALL DATA 
session fi le.  They are available for editing on the software.  If the editor is connected online with a console these 
scenes are the same as those shown in the console SCENE pop-up.  Recalling one of these scenes displays it in the 
editor windows and recalls it to the console.
The left side column is headed “FILE” and the scenes listed in this column are “scenes only”.  They are not 
“wrapped” in an ALL DATA fi le.  Once saved and transferred to a USB sorage device, they appear as a LIB fi le in the 
console SAVE/LOAD page.  

To SAVE the INTERNAL DATA scene list go to FILE>Save Session and save to your computers memory.  The fi le can be 
saved either as an .M7C fi le for transfer direct to a console via USB storage device or as a .YSE fi le for opening on 
the editor.  .YSE fi les cannot be opened on a console but they have the very small advantage of remembering the 
layout of the windows when opened in the M7CL Editor.   
To SAVE the FILE list of scenes use the SAVE AS button above the list.  This will also have the fi le extension .M7C but 
it is not an ALL DATA fi le, just scenes.  These will appear as a LIB fi le in the console SAVE/LOAD pop-up and can be 
opened into a console but always as a block of 300 scenes, so you will lose all scene data within the console. 

Note;Note; the current scene is not over-written in this special case of LIB loading. 
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Example; load a stored user effect from one session to another.

In this example let’s imagine that “Guest”, the vocalist is joining “The Examples” on stage.  “Guest” requires a 
special delay effect patch to suit his voice.  The special effect parameters are available in a different M7CLV3 fi le.  
There are two ways to transfer them;

1. Manually.  Open Studio Manager and M7CLV3 Editor and look at the parameters in “Guests” show fi le.  Then copy 
them manually into the show fi le of “The Examples” and store them.  This is acceptable if there is only one effect 
but if Guest was going to sing several songs with different effects it could be tedious and error prone.
2. Use M7CLV3 Editor to drag them across.

Before Guest Delay FX can be transferred from one fi le 
to another it must be stored to the effect library.  Using 
M7CLV3 Editor, open the scene with the effect, open the 
Effect Editor Window and store the effect to the library.  
(This might already be done by Guest’s engineer.)

Next, drag the stored effect from the right hand column 
(INTERNAL DATA) and drop in the left hand column (FILE) 
and confi rm.  You cannot choose library positions less 
than 056 as these are ROM for the Yamaha presets.

Save the new user library by clicking on SAVE above 
the FILE column.  This will save the library onto your 
computer as a .M7C fi le.  However it is important to 
understand this is not a M7CL session fi le, just an effects 
library.  For this reason we suggest you give the library 
a name that refl ects what its contents are, because it 
is easy to get it mixed up with other .M7C fi les if you 
don’t.  In this case we choose “GuestFX”.

You cannot directly load this library into a console, 
but you can drag library entries out and put then in a 
different session fi le.  
Close the “Guest” session and open “The Examples”.  
Open the Effect Library window.  

Next open the “GuestFX” library on the FILE side, by 
using the Open button above the FILE column.  (It could 
still open from the saving).

Drag the stored “Guest Delay FX” from FILE to INTERNAL 
data.  Choose a location that is free.
Now the Guest effect is available in the main band show 
fi le.

Library Window dragging.
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More Library Window dragging.  
This technique of dragging items across the library 
window will work for other library items too.  Channel 
library items for example; perhaps the guest has chan-
nel settings you want to copy from their fi le to yours; 
use the same technique.

In addition to the library items, scenes can be dragged 
in this way, but consider the alternative of using two 
editors instead; this skips the in between stage of saving 
to the PC.

An alternative to dragging from INTERNAL DATA to FILE 
and saving as a library fi le, is to open two instances 
of the M7CLV3 Editor.  The advantage of this is that 
two sessions can be opened at the same time and data 
dragged across from one to the other without going 
through the middle stage of saving.  This is particularly 
effective when one editor is on-line with the console 
and one is off-line.  You can drag from an off-line ses-
sion and drop directly into the console!  Take great care 
not to have two editors on-line with the console at the 
same time and name the editors to avoid confusion!

Using two M7CLV3 Editors.

To merge two bands scenes into one session fi le;
The procedure to drag a scene from one session into another (for example to merge two bands sessions when they 
appear in the same show) is;
Open two instances of the M7CLV3 Editor in Studio Manager. (One and Two)
Open each band’s session within one editor.
Open the Scene Window in both sessions and re-size all windows so that you can see both at the same time.
Drag required scenes from Editor One to Editor Two.  Choose vacant scene locations (probably new numbers).

Now the scenes from band One are available in band Two’s session.

Finally save this new session by 
File>Save As, rename and select the 
fi le type from .M7C or .YSE.
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Using Focus and Recall Safe to ensure the outputs work as expected.

When merging scenes into the same session like this we should take extra care to check that patching changes are 
not going to happen that render the process ineffectual.  For example if Band A outputs are patched to different 
Omni outs then possibly they won’t be heard!

Careful use of the knowledge learned in this guide can ensure that outputs remain routed to the correct Omni 
outputs and have the correct processing applied.  Use either Recall Safe or Focus to ensure this.
Focus can be set either from the scene window of the M7CL editor or the console. Use Focus to remove Output 
patching from recall and if necessary output processing like EQ and dynamics.  Don’t apply the “WITH SENDS” 
button or the sends levels feeding into the outputs will also be removed from recall.
Additionally you might wish to Safe any RACK GEQs from recall in the RECALL SAFE screen if you wish to use the 
GEQ settings set by the engineer whose session you are merging into.
If Recall Safe and Focus cannot cope with the patching requirements and changes, remember you can always use 
the editor to create a new patch for your old scenes.

Good luck and Enjoy mixing with Scenes!  
 www.yamahaproaudio.com
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